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COPYRIGHT
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LICENSE DISCLAIMER

Nothing on any MOST Cooperation Web Site, or in any MOST Cooperation document, shall be con-
strued as conferring any license under any of the MOST Cooperation or its members or any third
party's intellectual property rights, whether by estoppel, implication, or otherwise.

CONTENT AND LIABILITY DISCLAIMER

MOST Cooperation or its members shall not be responsible for any errors or omissions contained at
any MOST Cooperation Web Site, or in any MOST Cooperation document, and reserves the right to
make changes without notice. Accordingly, all MOST Cooperation and third party information is pro-
vided "AS 1S". In addition, MOST Cooperation or its members are not responsible for the content of
any other Web Site linked to any MOST Cooperation Web Site. Links are provided as Internet naviga-
tion tools only.

MOST COOPERATION AND ITS MEMBERS DISCLAIM ALL WARRANTIES WITH REGARD TO
THE INFORMATION (INCLUDING ANY SOFTWARE) PROVIDED, INCLUDING THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND
NON-INFRINGEMENT. Some jurisdictions do not allow the exclusion of implied warranties, so the
above exclusion may not apply to you.

In no event shall MOST Cooperation or its members be liable for any damages whatsoever, and in
particular MOST Cooperation or its members shall not be liable for special, indirect, consequential, or
incidental damages, or damages for lost profits, loss of revenue, or loss of use, arising out of or related
to any MOST Cooperation Web Site, any MOST Cooperation document, or the information contained
in it, whether such damages arise in contract, negligence, tort, under statute, in equity, at law or other-
wise.

FEEDBACK INFORMATION

Any information provided to MOST Cooperation in connection with any MOST Cooperation Web Site,
or any MOST Cooperation document, shall be provided by the submitter and received by MOST Coop-
eration on a non-confidential basis. MOST Cooperation shall be free to use such information on an
unrestricted basis.

TRADEMARKS

MOST Cooperation and its members prohibit the unauthorized use of any of their trademarks. MOST
Cooperation specifically prohibits the use of the MOST Cooperation LOGO unless the use is approved
by the Steering Committee of MOST Cooperation.

SUPPORT AND FURTHER INFORMATION
For more information on the MOST technology, please contact:

MOST Cooperation
Administration
Emmy-Noether-Str. 14
D-76131 Karlsruhe
Germany

Tel: (+49) (0) 721 966 50 00

E-mail: contact@mostcooperation.com
Web: www.mostcooperation.com
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1 Introduction

The MOST Editor is a state-of-the art software for editing MOST function catalogs.
As ease of use was one of the main goals in the development of the MOST Editor
the structure and handling uses mechanisms, icons, menus etc. common in today’s
editors to make basic functionality self-explanatory. The following XML formats for
saving and loading of function catalogs are supported: FIBEX, FCat DTD and FCat
XSD.

This manual describes how the MOST Editor works. It is not an introduction to the
MOST Specification nor does it explain the meaning of MOST elements.

This manual refers to version 3.4.0.12 of the MOST Editor distributed by the MOST
Cooperation.

Please contact mosteditor@mostcooperation.com for any remarks or requests con-
cerning the MOST Editor.
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2 Getting started

2.1 System Requirements
To use the MOST Editor you need a Windows System with Windows 2000 or higher.

2.2 Installation
You start the installation by double-clicking the MOST Editor install file

MOSTEditor-<Version>.msi.

A standard windows installer starts. The only two things you have to do during instal-
lation are to select the location where you want to install the MOST Editor and to ac-
cept the license agreement.

i MOST Editor Setup

Welcome to MOST Editor

M@ST Setup Wizard

The Setup Wizard will inskall MOST Editor an your compker,
Click. Mext bo conkinue or Cancel bo exit the Setup Wizard,

iy
-
re
il

Sulzer GmbH

MEXI::: i [ Cancel
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i MOST Editor Setup

Select Installation Folder S
This is the Folder where MOST Editor will be installed, M@ I

Toinstall in this Folder, click "Mext", Toinstall ko a different Folder, enter it below or click
"Browse",

Folder:
| CProgrammelMOST Cooperation\MOST Editor) w | [ Browse. ..

Advanced Installer

< Back ]uext:b i [ Cancel

i15, MOST Editor Setup X

End-User License Agreement M ST
Please read the Following license agreement carefully @ ]

Copyright (C) 2007 MOST Cooperation.

This software 15 provided 'as-12', without any expressed or implied
wWattanty.

In no event will the authors be held hable for any damages arising from
the use of this software.

For mternal consortium use only, do not redistribute.

{(¥)1 accept the kerms in the License Agresment

{1 do not accept the terms in the License Agreement

Advanced Installer

< Back ” Mext = ] [ Cancel
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& MOST Editor Setup [Z|
Ready to Install S
The Setup Wizard is ready to begin the Typical installakion M@ I
Click Install ko begin the inskallation, IF wou want to review or change any of your
installation settings, click Back. Click Cancel ko exit the wizard.
Advanced Installer
< Back. ]| Install | [ Cancel ]
i MOST Editor Setup E'
Installing MOST Editor M@ST
]
Flease wait while the Setup Wizard installs MOST Edikar,  This may kake several
rinutes,
Skakus:
(FEENNRRR AR RN RRRRNR RN RRRRREEE )
Advanced Installer
© Copyright 1999 — 2018 MOST Cooperation. All rights reserved.
Page 9 of 68

MOST Editor — User Manual 06/2018
Document Version 3.4.0.12



MOST® MOST

MOST Editor COOPERATION

i MOST Editor Setup

Completing the MOST Editor
Setup Wizard

Click the Finish button bo exit the Setup Wizard,

Sulzer GmbH

Einish
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2.3 MOST Editor - A quick walk-through

After installing you can start the MOST Editor either from the program menu of your
computer via Start - Programs -> MOST Editor > MOST Editor or by double-
clicking on the short-cut named “MOST Editor” on your desktop.

2.3.1 Startscreen

The welcome page is the first page you see when you launch the MOST Editor. You
can choose from a clearly arranged menu what do you want to do.

L OX

[ MosT Editor 3.0

What do you want to do?

Create a new MOST function catalog.

QOpen a MOST function catalog.

=
@ Exit from the application.
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2.3.2 Components

The main window of the MOST editor consists of several different areas.

Main menu

.MOST Editor 3.0 - [AMFMTuner_060710.xml :: FCat]

Task menu

/

Detail tree

Status bar

!
1) AMFMTuner_080710.xml

Toolbar Detail editor

identfer | ox|200 9 hex ()dec Section [Appication

- foo ATStationinfo [0x20. |\ Visbiity |publc ¥
% fiv ATSeek (0x204]

# fiv TPSmitch [0x4S0]

- foo RDSSmitch [0x451]
# fov REG (0x452]

@ fiv TAEscape [0x453]

@ fiv Autostore [Ox454]

@ fov TAInfo [0x455]

@ foo TAMessage [0x456]
# - foo PTY31Message (0x4!
4 fov Radiotext [Ox45A]

# foo ATPL_Freq [OxCO1]
@ foo ATRegionCode [OXC
# fov ATRegionCodelnfo [t
¥ foo TPStatus [0xCO9]

# fiv ATStations (0xC10]
- foo DTStations_Freq (0x
4 foo TestMode [OXC20]

@ foo TestData (0xC21]

@ foo PTY315witch (OXFSC

Occurrence |

Wel-known = Notification b

Parameter

CPType Channel Parameter
Pos, Data
9 Pos
FGet Pos, Data
ptus Pos, Data
gror ErrorCode, Erro...

Parameter

Data: Record
The content of Data depends on parameter Pos={x,y}.

Field Type
Enumeration
Erumeraton
Erumeration

Waveband
SubwWavebandFM
SubWavebandAM

Component

Purpose

Main menu

Using the main menu you can execute all file handling actions and
basic operations on elements.

Toolbar

The toolbar is a collection of icons that allows you to directly access
often-used commands. If you move your mouse over an icon a tool-
tip appears.

Status bar

The status bar shows the name of the file that is currently opened in
the MOST Editor.

Task menu

The task menu gives a structured overview of the elements in a
MOST file.

Detail tree

The detail tree shows the elements connected to the item that is
selected in the task menu. You can navigate through this structure
(click on “+” to expand and on “-“ to collapse the substructures).

A context menu enables a quick access to the elements in the detail

tree by just right clicking on it.

Detail editor

The detail editor consists of one or more tabs showing details of the
element that is selected in the detail tree. Which tabs are displayed
depends on the type of the selected element.

Page 12 of 68
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2.3.3 Create your first function catalog

When you have chosen to create a new MOST function catalog from the start screen
the following window appears:

[® MosT Editor 3.0

Fle Element Help

OO Beda BEX

MOST A

Details

Catalog
@ FBlock

fw Function
©9=Parameter
@ signal

% Unit

Analysis ¥

Unnamed | | [

In the main menu choose “Element” > “New”. The following pop-up window appears:

Element type A

Enter a type.

@ MOST FBlock

féo MOST Function
(9= MOST Parameter
@ signal

% Unit

[ ok ][ canca |

© Copyright 1999 — 2018 MOST Cooperation. All rights reserved.
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Select “MOST FBlock” and click “OK”.

MOST FBlock

\
Enter a name

for the new element.

Fiter | |
[ |Enter a sfring contained in an objec

[ ok [ cance |

Enter the name of your FBlock and click “OK”. An FBlock is created and the appro-
priate detail editor opens.

MOST Editor 3.1 El@

Ele Element Help
Q- O = BEx

™ MOST FBlock™ ™ MOST FBlock MyFBlock

MOST 7 l:] @ General | B Detals | @ References |
a8

Catalog Name [MyFBlock

@ FBlock L~
Description

fi Function P H? HTML

®)=Parameter

@ Signal

% Unit

MyFBlock

Analysis ¥

Versioning

Date [11/23/09

Changes

N | Change | Reason

x

Unnamed | [

In the tab called “General” of the detail editor you can enter a description for your
FBlock and add versioning information.

© Copyright 1999 - 2018 MOST Cooperation. All rights reserved.
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[® mosT Editor 3.0 E]@

File Element Help
O O~ = LB x

~ MOST FBlock

™ MOST FBlock MyFBlock

=@

My FBlock Identifier @ hex () dec

Kind |0peration |

Catalog
@ FBlock
fw Function
©=Parameter Visibility [public ']
@ signal
% Unit Functions

Analysis ¥

[ @new | [ #add | ®

Unnamed [ | I

In the tab named “Detail” of the detail editor enter an identifier.
At the bottom at “Functions” choose “New” to create a new function. The following
pop-up window appears:

© Copyright 1999 — 2018 MOST Cooperation. All rights reserved.
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MOST Function

Enter a name =

for the new element.

Filter  |MyFirstFunction l

| oK || cance |

Enter a name for your function and click “OK”.

[ MosT Editor 3.0
File Element Help

MOST

COOPERATION

O Bexa TEX

m ™ MOST FBlock stFunction
T A l:l ® General' B Detals | % References |

Catalog

Bmmesial || e Orec ok seen|

- fio % nction

. S sbity fpublc ] —
53 Function Visibility Qccurrence
@ signal
% Unit Function Class

lUncIassiﬁed Property v]
Anclyslo B @ Error: Atleast one OPType must be provided.

Error b3

Lo
OPTypes Parameter
OPType I Channel ] Parameter
»

B

x

Parameter

Unnamed I | [

© Copyright 1999 - 2018 MOST Cooperation. All rights reserved.
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The function is created and attached to the FBlock. The detail editor for the function
opens. As you have not yet entered detail information about your function it is not in
a consistent state. The “Error” section tells you what you have to do to make your
function consistent according to the MOST Cooperation’s specification of the xml file
that contains a function catalog. This is important as you can only save consistent
elements in your function catalog.

@ Error: At least one OPType must be provided.

Error *

For your newly created function this means that you have to add at least one OP-
Type. To do this click “Add” at the OPType-section in the “Details” tab of the detail
editor of your function. A pop-up window opens where you can select an OPType for
your function.

Choose one or more elements, @

Llist of elements

& Set
=y Get
=y SebGet

& Increment
& Decremnent
Zy Getlnterface
& Status

=y Interface

& Errar

| ok J | Cancel |

Choose for example “Set” and click “OK”. You can select multiple elements if you
want to add more than one OPType.

© Copyright 1999 — 2018 MOST Cooperation. All rights reserved.
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[® MosT Editor 3.0 g@

Ele Element Help

MOST A

Catalog
@ FBlock
fw Function
9= Parameter
@ Signal

% Unit

Analysis ¥

Unnamed

O BEea EX

~ MOST FBlock MOST FLnction MyFi ti
l:l @ General' B Details | % References |

8 g‘,};c‘k [Ox = Identifier @ hex (O dec Section I |
=5 - Visibility Qccurrence [:]

Virtuial :] Wel-known :] Noftification E]

Function Class

[Unclassiﬁed Property v]

Error v

Lenat

OPTypes Parameter
OPType | Channel | Parameter
Set
»~
N
< Add ® 1 B I P add || R
Parameter

An OPType “Set” is created. Please note that the “Error” section is empty now. Click
on the OPType “Set”. The “Parameter” area is activated. Click “New” to create a pa-

rameter.
[@l MosT Editor 3.4.0.2 %]
MOST Parameter Y
Enter a name
for the new element.

Filter |FirstPara meterl |

[ OK _J [ Cancel ]

Enter the name of your parameter and click “OK”.

Page 18 of 68
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Datei  Element Hilfe

Q-0 EBeHo TERX

| | (]| |/ @ Angemein | B Details { % Referenzen |

=+ fi MyFirstFunction [0x123]

Katalog B set Parametertyp | Void b

[ FRlock 'W= EigenschafterArray (legacy)

fio Funktion Array Type

(= Parameter BitField

@ Signal Boolean

% Einheit Classified Stream
Enum
Length-Coded String
Number
Record (legacy)
Record Type

Short Stream
Streamn

String
T [T]
E A.meds | | 25 of 32M (max 494M) |1

The detail window for the newly created parameter opens. You can change the pa-
rameter type here. Depending on the parameter type you have to enter additional
information about your parameter. Now select in the main menu “File” - “Save”. En-
ter a filename and click “OK”.

You have created your first function catalog using the MOST Editor.

© Copyright 1999 — 2018 MOST Cooperation. All rights reserved.
Page 19 of 68

MOST Editor — User Manual 06/2018
Document Version 3.4.0.12



MOST® M@S’I;

MOST Editor COOPERATION

3 Working with the MOST Editor

3.1 Using elements in the MOST Editor

FBlock, Function, Parameter, Signal, and Unit are different elements the MOST Edi-
tor works with. The basic mechanism for creation, editing, deletion, copy and com-
parison is the same for all these elements.

3.1.1 Create elements

There are several ways to create new elements. Which one you choose depends on

your personal preferences.
1. New element
Choose in the main menu “Element” = “New’

[@ MosT Editor 3.4.0.2 - [FCat-Example_DTD_1V2

L]
|_|<} - r T A Y
|Create5 a new Elementi

= Shallow copy... TI-C

= Deep copy.. Crl-D

b4 Delete Drzlete

rEI*EI Compare with... -3 Prop

ﬁxa Functicn . |

A new window opens where you can choose which type of the element you
want to create.

Element type ‘
Enter a type
of the new element.

8 MOST FBlock

foo MOST Function

(9= MOST Parameter

7% Unit:

@ signal

|‘ OK l [ Cancel I

Choose for example “MOST FBlock” and click “OK”. Another pop-up window
opens where you can enter the name of the element you want to create.
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@ MOST Editor 3.0

MOST FBlock
Enter a name

for the new element.

MOST®
MOST Editor

Filter |NextFBlock

Lo ]

Enter a name and confirm by clicking “OK”.

@ MmosT Editor 3.0

File Element Help

Q- O

BEecEa B X

[+ e
@ FBlock @ik
fio Function

®)=Parameter

@ Signal
7% it

Analysis ¥

e

El catalog ‘_i yFBIoc [

® General' B Details | % References |

Identifier & hex () dec

Kind | |

vishility [public -

Functions

The element is created and opened in the detail tree and in the detail editor
for you to complete it.
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2. New element (same)

In the task menu mark the type of the element you want to create. For exam-
ple select FBlock. Choose “Element” - “New (same Type)” from the main

a
menu or press E in the toolbar.

[@ MosT Editor 3.4.0.2 - [FCat-Example_DTD_1V2-1.medb]

5h3|| Creates a new element of the same type

= Deep copy.. Crl-D

¥ Delete Dizlete i “‘_ : .
- PropertiesWithMu

- i PropertiesWithin

Compare with...

8
ﬁﬁci Functicn . I

A pop-up window opens where you can enter the name of your element. The
element gets created and the appropriate editor opens.

3. Create an element in the detail editor of a superior element.
For example you can create a function in the detail window of an FBlock.

[® mosT Editor 3.0 D@@

File Element Help
OO Bela BB X
;; :
[ MosT @ [ ] ® General' B Detais|| % References |
S8 |hyFRiock [0x12] Identi - = ~
T o lentifier | Ox ® hex (O dec
,E;tjclig B fio MyFirstrunction o4 =

FioFunction @ NextrBiock Kind |Operau‘on |

®)=Parameter Visibility [pUinC 'I
@ signal

% Unit Functions

fro MyFirstFunction (0.0.1)

Analysis ¥

WNew | [ dadd | ®

[5 Unnamed | [ |

Pressing “New” at the bottom of the “Details” tab of an FBlock opens the di-
alog to create a function.

After you created an element you have to enter the appropriate data in the detail edi-
tor.

3.1.2 Edit elements

Select the element you want to edit in the detail tree. The appropriate editor opens in
the detail editor window. The editor window contains different tabs that display infor-
mation about the selected element and allows you to edit the data of the element.
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[® MosT Editor 3.0 Q@g

File Element Help
O BzRa HEX

™ MOST FBlocks MOST Function MyFirstFunction
= \ a7
T = () |:] @ General' B Detals | % References |
B Catalog = @ MyFBlock (0x12] Identifier @ hex (O dec  Section |Coordinau‘on ]
8 Felock y My Firstrunch..
bt - [@ NextFBlock ity |p 3
= Parameter Virtual [j Well-known [:] Noftification [:]
@ signal
7% Unit: Function Class
[Unclassiﬁed Property vl
Analysis ¥
Error v
Lena
OPTypes Parameter
OPType ] Channel [ Parameter
Set FirstParameter s
N
< Add ® 4 %
Parameter
FirstParameter: Void

[5 Unnamed | | |

3.1.3 Delete elements
Select the element(s) you want to delete in the detail tree. Then choose “Element” ->

“Delete” from the main menu or * from the toolbar or right-click on one of the se-
lected elements in the detail tree. The MOST Editor asks you to confirm the deletion
of the selected element(s).

MOST Editor 3.0

A Do you really want to delete the elements?

If the elements you marked for deletion are referenced by other elements you cannot
delete them. You have to delete the references or the referencing elements first.

° The element. Ty FirstFunction’ references the element 'FirstParameter',
Flease remove the reference first,

3.1.4 Single shallow copy of an element

In the detail tree mark the element you want to copy. Please note that you can only
copy one element at a time. If you mark more than one element only the element you
marked last will be copied. Then choose “Element” - “Shallow copy...” from the
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main menu or click "= in the toolbar or right-click on the element you want to copy
in the detalil tree.

[@ MosT Editor 3.4.0.2 - [FCat-Example_DTD_1V2-1.

Help

|j' Mew...

|_|¢' Mew (same Typel., CirlN

BB Shallow copy... Crl-C ]

= Deep copy... Crl-D

3 DE|EtE|C|:|piesthe Elementh - [ Methed

~E - ] i Properti

g Compare with... i Propert
ﬁd Functicn .'|'|_

A window opens where you can customize your copy.

[@ MosT Editor 3.4.0.2 x|

Shallow copy Y
Fill in the copy parameter -Igﬁ] |

@ simple copy

name |Meth|:u:|5. (copy) |

) multiple copy

() Copy with counter start quantity places

replace pattern

chject name preview
| |

[ Ok J [ Cancel ]

Enter a name for your copy and select “OK”. A copy of your element with the name
you specified is created.

3.1.5 Multiple copies of an element
You can create multiple copies of an element.
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Choosing “File” - “Copy” in the main menu or "= in the toolbar or right-click on the
element you want to copy in the detail tree opens the following dialog:

[@ MosT Editor 3.4.0.2 x|

Shallow copy b
Fill in the copy parameter -|L'::m '

() simple copy

name |i|tiE£ WithSingleParameter (copy) |

3  multiple copy

() Copy with counter start guantity places

replace pattern

chject name preview

| PropertiesWithSingleParameter 01 ... PropertiesWithSingleParameter_10 |

[ OK J [ Cancel ]

You can customize the names of your copies by specifying a prefix and a suffix for
the name of the new elements.

3.1.6 Deep copy of an element

To create a deep copy of an element including all references choose “Element” >
“‘Deep copy...” from the main menu or right-click on the element you want to copy in
the detall tree.

[@ MosT Editor 3.4.0.2 - [FCat-Example_DTD_1V2-1.

ew (same Typel.. Cul-N

Shallow copy.. Ctrl-C H I:“

E Deep copy.. Ctrl-D

® Delete |Deep copies the eler‘nentE Propertie
fais] :

&5 Comparewith.. = Propertie

ﬁxa Functicn
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The copy rules and the dialog to customize your copy is same as described in 3.1.4

3.1.7 Compare elements

To compare two elements you can select both in the detail tree and then use “Com-
pare with each other” from the context menu. Alternatively, you can select one ele-
ment, then use “Element” - “Compare with” from the main menu. A pop-up window
opens where you can select the second element for the comparison.

Please note that the compare function from the context menu and the compare func-
tion from main menu slightly differ: In the context menu you select two elements that
will be compared with each other. If you use the compare functionality in the main
menu you select one element in the detail tree. Then you use the dialog “Element” >
“Compare with” to find the second element for the comparison. If you have selected
two elements in the detail tree the comparison “Element” - “Compare with” from the
main menu does not compare the two selected elements but compares the last se-
lected element with the element you choose from the dialog opened by “Element” >
“Compare with”.

@ mosT Editor 3.0

File Element Help
@O Belo B X

™ MOST Felock NextFBlock
@ General' B Details | @ References |
[2 catalog () hex () dec
8 FBlock i W8S 3¢ Delete ]
fio Function =" Compare with each other
)= Parameter v -
@ signal Compares two selected objects |

% Uniit Functions

[

The result of the comparison is displayed in a new pop-up window. The two FBlocks
differ in the OPType Error in the function MyFirstFunction:
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@ mosT Editor 3.0 @
Compare i
Compares two elements with each other, its atfributes and associations. L —@3

MOST FBlock MyFBlock (0.0.1) | MOST FBlock NextFBlock (0.0.1)

LH0ST FElock MyFBlock (0.0.1) Attributes MOST FBlock MOST FBlock
=8 MOST function MyFirstFunction (0.0.1)

-8 OPType Set kind Operation
=& OPType Error

[ Export... ]| Close ]

The differences between the two compared elements can be exported into an XML
file that can be viewed in a Web browser.

| Vergleich zweier Elemente - Microsoft Internet Explorer B@g
Datei Bearbeiten Ansicht Favoriten Exftras 2 &
@Zumck - © & @ ,h /7\Suchen i}( Favoriten &) (2~ 7\‘ =m a3
Adresse | =] D:\Projects\EEDB\Probleme200910242009.02.06\diff2.xml v | B wechsenzu Links >
0 MOST FBlock MOST FBlock MyFBlock (0.0.1) MOST FBigca‘ge"tFm“k
identifier 0x12
kind Operation
= MOST function 1 MOST function MyFirstFunction (0.0.1)
. MOST function [ MOST function
1MOST humstion MyFirstFunction (0.0.1) MyFirstFunction (0.0.1)
OPTypes Set Error
+ OPType OPType Set
- OPType OPType Error
&1 Fertig 140 Arbeitsplatz T

After removing the OPType Error the comparison results in the following message:
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Message

@ The elements are equal

3.1.8 Unmerging elements

MOST-Functions and Parameters referenced by multiple elements may be un-
merged. The numer of references is displayed in perentheses next to the name for
those elements. Let’'s assume “Function A” is used in two FBlocks “FBlock A” and
“FBlock B”. Unmerging this Function will create a new Function “Function A*” so that
“FBlock A” uses “Function A” and “FBlock B” uses “Functions A*” afterwards. To un-
merge an element select it in the tree and choose “Unmerge...” from the context
menu:

[@ MosT Editor 3.4.0.2 - [FCat-Example_DTD_1v2-1.medb]

Eile  Element Help
G- Bedo TERERX

= MOST Parameter BooleanParam

| m General\{ = Details\(% References‘\

Catad ---(><]= BitsetParameterWord |
talog B-09= Blockwidth

z FB|DC|.( ---[><)= BooleanParam (4) Description Iﬂla HTML
Function (4= Boolez One-bit Boolean parameter,
()= Parameter ---[le: Booles
B-(4= Boole

Mame |Bualear1|:'aram

Mew...

|i=| Shallow copy... Cwil-C
B-69= CStrea ”rg Deep copy... Ctri-D
0= Chanr| % Delete Delete
B-0d= Chann % Deep Delete..  Cu-T

BH-(0= Currey

E-09= DataDés

'"[x:'= DataType (2) | Unmerges the element... h
()= EnumParam 1T

@ Signal
™™ Unit

3.2 Editing a function catalog

A MOST function catalog is stored either in a file-based database (*.medb) or in an
xml file that follows a structure defined by the MOST Cooperation. The MOST Editor
allows you to comfortably work with a function catalog.

3.2.1 Open an existing function catalog

When you start your MOST Editor the welcome screen appears where you can
choose to open an existing function catalog.
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[® mosT Editor 3.0 Q@[Z]
Welcome I

MOST Editor

What do you want to do?

—
f 7 Open a MOST function catalog|Opens a MOST function catalog|

&= [ [

If you are already working with the MOST Editor and you want to open a new file you
can return to the welcome screen by choosing “File” - “Close”. Alternatively, you
can open a function catalog by choosing “File” - “Open” in the main menu, the

open-function-catalog icon < in the toolbar or by drag&drop from the Windows ex-
plorer. If you choose “Open” you can select a MOST xml file from your file system. In
this case closing the current function catalog and opening the new function catalog
will be done in one step.

Look In: [D Samples '] ENAIES]

(3 FCat Bsp - FIBEX Bsp [E) Auxin Rev 4 Version number

3 MOST-Co B FCat-Examp

3 Problem - HTML-Generierung FCat-Examp

3 Referenz [5) FCat-Examp -~

5 @) from file

) 3G_DvDvideoPlayer_0x034.xml [E) MyCompare g

Bl 36_TvHybrid_Ox0CA_¥0_3_1.xml B MySample.x| ) uniform :I

B AMFMTuner_060710.xml Bl tele.xml

< T ] [»

File Name: | ‘

Files of Type: IFIBEX Files/Function catalogs {*.xml) v]
Open || Cancel

A MOST function catalog can be loaded from an MEDB file or from an XML file in
either FCat DTD format or in FIBEX format. Depending on the contents of the file the
MOST Editor can automatically decide in which format the file was saved and loads it
accordingly. In the dialog one can provide a uniform version number that will be as-
signed to all imported elements. Otherwise, the version numbers read from the file
will be assigned to the imported elements.
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3.2.2 Create a new function catalog

When you have just started your MOST Editor you can choose “Create a new MOST
function catalog.” from the welcome screen.

[® MosT Editor 3.0 Q@@
Welcome }

MOST Editor

What do you want to do?

1 Create a new MOST function catalog.

|Creates a new MOST function catalor

0=

% [ | [

The MOST Editor can handle only one function catalog at a time. If you have already

opened a function catalog in your MOST Editor you have to close it in order to create
a new function catalog.

In the main menu choose “File” > “New” to close your current function catalog and
create a new one or use the create-function-catalog icon = from the toolbar.

[® osT Editor 3.1 Q@@

File Element Help
Q- O o BB X

B Function catalog Attribute

b
MOST a | @ General |
Catalog Versioning
@ FBlock version | |
fw Function
©9=Parameter Date | [v]
@ signal
™ Uit [ | company
Changes
Analysis ¥ T | Change | T

[5 Unnamed [ [

Selecting “Catalog” in the task menu and “Attribute” in the detail tree allows you to
enter general information like author and version for the function catalog. This infor-
mation can be used to distinguish different versions of a function catalog and to iden-
tify the person in charge of the maintenance of the function catalog.
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3.2.3 Importing from existing function catalogs

If you want to reuse elements from an existing function catalog in the function cata-
log you are working with you can import these elements. In the main menu select
“File” = “Import” and choose the file that contains the function catalog you want to
import.

The Following elements will be imported. @

[ rmFBlock (0.0,1) fox123]
foo MyFirstFunction (0,017
()= FirstParamaker (0.0,1)

Llist of elements

x|

A pop-up window shows you which elements will be imported. Click “OK” to close the
window.

3.2.4 FCat MOST Import Errors and Warnings

The file that is to be imported must be a valid XML file. It must satisfy the constraints
imposed by both the DTD and the MOST specification.

An XML file can be completely imported only if it satisfies all the constraints. Other-
wise the import may be incomplete/wrong.

If the file does not satisfy a constraint, the following message in a yes/no dialog will
be shown:

MOST Editor 3.0

A Some errors occured during the import. Therefore the import can be incomplete. Do you want to have a look at the error file?
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By choosing "yes" a list of error and warning messages is shown in a text editor. By
choosing "no" the messages are not shown.

The list of error and warning messages is saved in the same directory from where
the imported file was loaded and with the same name but with the extension ".txt".
You can have a look at the messages at any time.

The constraint violations are separated by their severity into two groups: errors and
warnings. A constraint violation is an error if it leads to an incomplete import of a
MOST element (block, function or parameter) or even if the corresponding MOST
element cannot be imported at all. All import problems that could only lead to a par-
tial loss of information (for example, when a date attribute could not be parsed) are
considered as warnings.

If an error occurred it could be the case that no MOST FBlock could be imported.

The error and warning messages have a special format containing the exact position
in the XML file (the line and column number of the corresponding XML element), the
MOST element position in the form

<Block>.<Function>.<Parameterl>.<Parameter2>..
and the message itself describing the constraint that was violated.

Let us consider some examples of possible warnings.

1) [23, 17] AMFMTuner.ATWaveband.: Obsolete function sections found
2) [2654, 40] AMFMTuner.TestData.TunerData.: No valid discriminator
parameter found.

The first warning message should be read as follows:
At line 23 and column 17 in the XML file an obsolete function section was found in
the function "ATWaveband" that is a part of the block "AMFMTuner".

The second warning message means the following:

At line 2654 and column 40 an XML element describing a discriminator parameter
was expected at the parameter "TunerData" referred from the function "TestData"
that is referred from the block "AMFMTuner".

3.2.4.1 Warnings

1 | The date {0} is incorrect.

A date is expected to be in one of the following formats:

a) "yyyy-MM-dd" (for example, "2007-12-21")

b) "yyyyMMdd" (for example, "20071221")

c) "dd.MM.yyyy" (for example, "21.12.2007")

d) "dd MMMM vyyyy", locale ENGLISH (for example, "21 December
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2007")
e) "yyMMdd" (for example, "071221")

The function classification ‘Array of Record' is deprecated. The function classifi-
cation 'Array' will be used instead.

The function classification 'Dynamic Array of Record' is deprecated. The func-
tion classification 'Dynamic Array' will be used instead.

The function classification 'Long Array of Record' is deprecated. The function
classification 'Long Array' will be used instead.

Obsolete function sections found

The parameter must be of type Array.

The parameter must be either of type Record or of type Array.

There is an OPType with several parameters on the same position.

O | 00| N|O | O

In a Record there are several parameters on the same position.

10

In a StreamCase there are several parameters on the same position.

11

The element does not have a valid class identifier.

12

The element does not have a valid subclass identifier.

13

The function has an unknown classification. A valid function classification is as-
signed.

14

The element does not have a valid identifier.

15

The flag "details" must be set to "false" when a dummy parameter is exported.

16

The parameter must be of type CStream.

17

A parameter of type Number must have a corresponding TypeRef.

18

The parameter must be of type ShortStream.

19

The attribute value is incorrect.

20

For a parameter of type Stream: TypeRef="type_stream".

21

The parameter must be of type String.

22

For a parameter of type Void: TypeRef="type void".

23

No valid discriminator parameter found.

24

Multiple discriminator parameters found.

25

The ramified stream parameter does not contain a discriminator parameter.

3.2.4.2 Errors

1

Unknown visibility
An unknown visibility value was found.
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Unknown function classification.

Unknown OPType.

The parameter must be of type Boolean.

For an enumeration parameter: TypeRef="type_enum".

For a stream parameter: TypeRef="type_stream".

The element has an invalid number format.

Unknown parameter type: {0}. A valid parameter type is assigned.

O (N |d | W|IN

There are multiple definitions of an OPType in a function.

=Y
o

For a boolean parameter: TypeRef="type boolean".

|_\
|_\

The parameter must be of type Enumeration.

[EEN
N

In an ordered collection only one object may be set to one position.

3.2.5 FCat MOST Export Errors and Warnings

3.2.5.1 Errors

1 | Both units with names {0} and {1} have the same 'ID".
Please assign a unique "ID".

2 | The unit with the name {0} has an empty ID. Please assign the unit a unique
"ID".

3 | The unit with the name {0} has an invalid ID. Please assign the unit a valid "ID".

The XML export requires that at least one FBlock should be exported. No
FBlock was selected for the export. (DTD format only)

Infinite recursion in parameters: {0}

The parameter {0} of type "ArrayOfRecord" must contain a parameter of type
"Record".

At least one OPType must be provided.

Multiple occurrences of the parameter {1} in OPType {0} are not allowed.
The OPType {0} is not allowed.

10 | The parameter {0} of type "Record” may not contain parameters of types Void or
Record.

11 | The parameter {0} of type "Stream™" must contain only parameters of the follow-
ing types: Boolean, BitField, Number, Enumeration, String, Stream, CStream,
ShortStream, Length-Coded String, Array Type, Record Type or Void.

12 | The parameter {0} of type "Record" must contain at least one parameter.
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13 | The parameter {0} of type "Array" may not contain a parameter of type "Void".

14 | The parameter {0} of type "Array” must contain a subparameter.

15 | The parameter {0} of type "Number" must contain a unit.

16 | The parameter {0} of type "BitField" must contain at least one value range.

17 | The parameter {0} of type "Boolean™ must contain at least one value range.

18 | The parameter {0} of type "Enumeration” must contain at least one value range.

19 | The function {0} must contain the discriminator parameter {1}. Otherwise the
discriminator parameter cannot be exported.

20 | The parameter {0} of type “Stream” contains a discriminator parameter that can-
not be exported due to missing Stream cases.

21 | The complex stream parameter {0} does not have a discriminator parameter.

22 | OPType {0} expects at least one parameter

23 | The parameter {0} of type “Record” may contain a parameter of type 'Array' only
on the last position of the record.

24 | The parameter {0} of type Number must contain a unit.

25 | The parameter {0} has an invalid value range that lies outside of the available
data type values.

26 | The parameter {0} has overlapping value ranges.

27 | OPType {0} does not expect a Parameter

28 | OPType {0} expects at least one parameter

29 | OPType {0} expects {1} parameters

30 | OPType {0} expects exactly one parameter

31 | The parameter {0} of type Array contains the attribute "size" with the wrong val-
ue: {1}. Allowed values: [0-9]+|Nmax

32 | OPType {0}: [Specific to FCat 0.6.05.3 format] Expecting {Boolean (lega-
cy)(UnsignedWord), Boolean (legacy)(UnsignedByte), Boolean (lega-
cy)(UnsignedLong)} instead of Number(UnsignedWord)

3.2.5.2 Warnings

1 | The following functions, parameters and signals are not referenced and are thus
not saved: {0}

OPType {0} does not expect a Parameter.

3 | The parameter {1} of type "Stream" in OPType {0} must be on the last position.

The parameter {0} of type "Record" may contain a parameter of type "Array"
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only on the last position of the record.
5 | The parameter {0} of type "Record" may contain a parameter of type "Stream"
only on the last position of the record.
6 | The parameter {0} of type "Stream" contains a discriminator parameter that
cannot be exported due to missing Stream cases.
The complex stream parameter {0} does not have a discriminator parameter.
8 | The discriminator parameter {1} of the stream parameter {0} has no correspond-
ing optype.
9 | The parameter {0} of type "ArrayOfRecord"” must contain a parameter of type
"Record".
10 | Parameter "{0}" uses invalid stream discriminator: selector needs to precede the
streams it controls.

3.2.5.3 Function constraint errors

The constraints below describe the dependency of the types of function parameters
on the function type.

1

A function of type "Number" may contain only direct parameters of the following
types: Number, Void.

The funktion {0} contains a discriminator parameter {1} that cannot be exported
(not BitEncoded).

A function of type "Text" may contain only direct parameters of the following
types: String, Void.

A function of type "Enumeration” may contain only direct parameters of the fol-
lowing types: Enumeration, Number, Void.

A function of type "Container" may contain only direct parameters of the follow-
ing types: CStream, Void, Stream and ShortStream.

A function of type "Record"” may contain only direct parameters of the following
types: Record, Number, Void.

A function of type "Array" may contain only direct parameters of the following
types: Array, Number, Void.

A function of type "Sequence Property” may contain only direct parameters of
the following types: Boolean, BitField, Number, Enumeration, String, Stream,
CStream, ShortStream, Array Type, Record Type, Void.

A function of type "Unclassified Property" may contain only direct parameters of
the following types: Boolean, String, Enumeration, BitField, Stream, CStream,
ShortStream, Record, Array, Array Type, Record Type, Void.

10

A function of type "Trigger" may contain only direct parameters of the following
types: Number, Void.
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11 | A function of type "Switch", "Boolfield" or "Bitset" may contain only direct para-
meters of the following types: Boolean, BitField, Void.

12 | A function of type "Sequence Method" may contain only direct parameters of
the following types: Boolean, BitField, Number, Enumeration, String, Stream,
CStream, ShortStream, Array Type, Record Type, Void.

13 | A function of type "Unclassified Method" may contain only direct parameters of
the following types: Boolean, String, Enumeration, BitField, Stream, CStream,
ShortStream, Record, Array, Array Type, Record Type, Void.

3.2.6 FIBEX Export Errors and Warnings

3.2.6.1 Errors

1 | The function {0} does not have a valid identifier. Its value must be between 0
and 4095.

2 | The function {0} having a component-by-component access has a Record pa-
rameter {1} with less than two fields.

3 | The function {0} having a component-by-component access does not have a
Pos parameter.

The parameter {0} of type "Record" must contain at least one record field.

5 | The parameter {0} of type "Stream" is bit-encoded, but lacks a discriminator pa-
rameter.

6 | The parameter {0} of type "Stream" has a discriminator parameter, but is not bit-
encoded.

The parameter {0} of type "Stream" has a stream case without code.

The parameter {0} of type Stream containing several cases must have a discri-
minator parameter.

9 | The parameter {0} of type "Stream" (or "ShortStream") has a stream case with-
out parameters and signals.

10 | The signal {0} has no valid value for length.

11 | The block {0} does not have a valid identifier. Its value must be between 0 and
255.

12 | The parameter {0} of type "Stream” with many stream cases must contain a dis-
criminator parameter.

3.2.6.2 Warnings
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1 | The function {0} has modifications that cannot be exported (their change or rea-
son fields are empty).

2 | The parameter {0} of type "Stream" with one stream case is not bitEncoded.
Therefore its code cannot be exported and is redundant.

3 | The parameter {1} of type {0} with one stream case has a description that can-
not be exported.

4 | The block {0} has modifications that cannot be exported (their change or reason
fields are empty).

3.2.7 FIBEX Import Errors and Warnings

3.2.7.1 Errors

1 | Unknown OpType: {0}

3.2.7.2 Warnings

1 | In a Record there are several parameters on the same position.

2 | In a StreamCase there are several parameters on the same position.

3 | The coding of a boolean/bitfield parameter has a bad format: {0}. It must have
the following format: (-)*[01](-)*.

No parameter with Id {0} was found.

Unknown function classification: {0}.

Unknown parameter type: {0}.

3.2.8 MOST Editor Window Title
Unless a function catalog was loaded (with “File” > “Open”) or saved for the first
time in a file (with “File” - “Save”) the window title contains only the version number.

Otherwise it consists of three parts:
MOST Editor <Version Number> - [<File Name> :: <File Format>]
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MOST Editor 3.0 - [AmFmTuner.xml :: FCat]

File Element Help
O Bela IEX

~ MOST Felock ~ MOST FBlock Am

Catalog R A mEmTiner [0x40] et 7
{8 Felock ) =
Jeo Eunction Kind |Receiver
)= Parameter Visibility |public
@ signal

Two file formats are possible: FCat and FIBEX. In this particular example, the file
“‘“AmFmTuner.xml” was loaded in the format FCat by the MOST Editor of the version
3.0.

3.3 Working with MOST FBlocks

A function catalog needs at least one MOST FBlock. A MOST FBlock has three tree
tabs in the detail editor. In the “General” tab you can edit the name and description of
the FBlock. You can use the versioning and the changes section to maintain a
change history of your FBlock.

@ MmosT Editor 3.0 - [FCat-Example_DTD_20080208-V2.1.xml :: FCat]

File Element Help
G O o TEX

Task ™ MOST FBlock™ T MOST FBlock Methods

e ) 5
MOST A l:l @ General | B Detals | % References |
f “E‘ﬁ"?"-’ i 2] - Name [Melﬁods
roperties WithMultilePe
@ rBlock B
fiv Function - @ PropertiesWithsinglepar, | Description m]
®=Parameter Contains example functions of all method function classes.
@ signal
7% Unit

[ catalog

Analysis ¥

Versioning

version [0.0.1

|
Date |Fri 08/31/2007 [+
l

Author [WG FEF Comparty [MOST Cooperation

Changes

Change | Reason .-

Initial version

FCat-Example_DTD_2... | [ |

In the “Details” tab you can set the identifier and the visibility of your FBlock and at-
tach functions.
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MOST Editor 3.0 - [FCat-Example_DTD_20080208-V2.1.xml :: FCat]

File Element Help
OO Beda BEX

[ MOST FBlock Methods
@ General' B Detals | % References |

MOST A
Identifier | Ox |72 @ hex () dec
E;Igil ig @ PropertiesWithMuitiplePz | I ‘
fioFuncton @ PropertieswithsingiePar, Kind |Reserved |
©=Parameter Visibility Ipublic ']
@ signal
7% Unit: Functions
frv SequenceMethod (0.0.1) {OxCO1]
Analysis ¥ fo TriggerMethod (0.0.1) [0xC00]

lﬁv UnclassifiedMethod (0.0.1) [0xC02]

H New ] I <k Add ] ®

[5) Fcat-Example_DTD_2... | [ [

If you select “New” at the bottom of the “Details” tab a new function is created and
attached to the FBlock. If you select “Add” an existing function is attached to the
FBlock. To remove a function from the selected FBlock mark it and click on the “Re-
move” button. The removal from an FBlock does not delete the function. It still exists
and can be reused in different FBlocks.
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3.4 Working with functions

The key tab to edit functions is the “Details” tab in the detail editor.

MOST Function ATFrequency

® General' B Detals | % References |

Identifier ‘ Ox 1206 | @ hex () dec Section ‘Apphcauon ‘ (<]
Visibility |public v Occurrence " Il
virtual [ v‘ wel-known A Notification ‘:}
Function Class
[Number "
, It has three Boolean-
Error H H
valued attributes: Vir-
tual, Well-known and
OPTypes Parameter . .
- OPType | Channel Parameter NOtIflcatIOI’] . The
- Fequncy N attribute Occurrence
St [ can take three val-
e b nrme ues: CONDITIONAL,
[ #ed ] ; - MANDATORY  and
T OPTIONAL. The four
(siehe Kap."Protokolle auf Applkationsebene: OPType" in [1]) attnbutes Can be |eft
ErrorInfo: Void empty Dependlng On

(siehe Kap."Protokolle auf Applkationsebene: OPType" in [1])

the value of the
attribute Identifier the

Flags, Class, OPTypes, Name, Units, DataType, Exponent, Min, Max, Step: Void

Frequency: Number

Range | Unit calculated attribute
153, 154 .. 162549, 162550 not defined H H
e Section can take its
Number of steps for adjustment. Val u e S .
Range ‘ Unit =
ot defined E

You can set the attributes of your function, add and remove OPTypes. When you
select an entry in the OPTypes section by clicking on it you can add new (Button
“‘New”) and existing (Button “Add”) parameter to your OPType. At the bottom part of
the panel the function parameters with their short description are shown. The
attribute “Function Class” can take the following values:

Funkti

[switch

Unclassified Property

Mumber
Text
Enumeration

\array

Dynamic Array
Long Array
Record

Sequence Property
Eoolfield

Bitset

Container

Map

Collection
Unclassified Method
ITrigger

Sequence Method
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MOST Function MyFirstFunction
@ General ' B Detais "'..@7 References “L

Identifier | Ox| @ hex O dec
Visibility |pLiblic v‘ Oceurrence |:
Wirtual v[ Wel-known [:

A MOST function with the function class ,Unclas-
sified Property“ contains an attribute Length. The

Function Class

[Unclassiﬁed Property X . i R
attribute is not editable. It can get its value when
eror the function is loaded from an FCat file. Its value
will be exported to an FCat file when the function
— is saved.

MOST Function MyFirstFunction
® General' B Detals |  References |

A MOST function with the function classes
“‘Array”, “Dynamic Array” or “Long Array”

resit | | @hex Oa contains one or more boolean access

veblty [k 3 Oeeurrerce attributes depending on the subparameter

v [ o] Kyekknonn type of the Array parameter of the func-

Function Class tion.

|rray It contains one boolean access attribute
‘component by component” if the subpa-

Error rameter type differs from Record.

Access || component by component

MOST Function MyFirstFunction i}

@ General' B Detalls | % References |
' If the Array-parameter of

Identifier | 0><I l(é}hex (O dec Section l: the funCtion haS a ReCOFd-

visbitty [pupic <] ocourence [ -] parameter as its subpara-

wnd [ o webknown [ -] meter then the function

Function Class contains three boolean

(array access attributes: “compo-
nent by component’, “row

Error by row” and “column by
column”.

Access || component by component [ |row by row [ column by column

MOST Function MyFirstFunction

g Y Y
@ General ' B Detals | % References |

Identifier I 0><I | (@) hex
visbity [pubic  ~| Oceurre
WVirtual [:‘ Well-kn
Function Class
[Record
A MOST function with the function class
" Record contains one boolean access

attribute “component by component”.

Access || component by component
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For shared functions (i.e. functions used by different FBlocks) the MOSTEditor sup-
ports overwriting the shared FktID in the tab “Shared references”. In the table “Ref-
erences” all referencing FBlocks are listed. To overwrite the FktID edit the entry in
the “Override shared FktID” column. In the following example FktID 0x4B0 of Func-
tion “SelectMediaListinfo” has been overwritten to 0x222 for “Methods”. The overwrit-
ten FktID is displayed italic in the tree view:

| | f@ General\; i Details\;% Referencesf% Shared References

- [ DVDVideoPlayer [0x34]

Shared function [ Make shared l [ Un-share/un-merge selected ]

E_I i Method5[0x35]
RN s ccthtcdoLisinto [0480) )|
Come ﬁsaTnggerMethod[uxcou]

- ffo SequenceMethod [0xC01]

. ﬁrd UnclazzifiedMethod [0::C02]

References

Reference =

™ DVDVideoPlayer [0x34]
@ Methads [0:35]

Override chared FltlD

. -3 PropertiesWithMultipleParameters [0:33]
- i PropertiesWithSinglePararmeter [0x32]

3.5 Working with parameters

The Details tab of a parameter is separated in two areas: From a drop-down menu
you can select a parameter type. Depending on the parameter type the properties
area lets you enter the details required for the selected parameter type.

Parametertyp |Void 3
- EigenschafteqArray (legacy)

Array Type

BitField

Boolean

Classified Stream
Enum
Length-Coded String
MNumber

Record (legacy)
Record Type

Short Stream

Stream

String

Parameter type void has no additional properties but number for example
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MOST Parameter SLongParam
@ General' B Detais S\I @ References\

Parameter type {Number vJ

Properties

Base Type [SignedLong vJ

Lower limit _ (@ hex () dec  Upper limit (&) hex () dec

Exponent: [0 !

Value Range | |

Step |1 |

unit. [none | [

or enumeration

MOST Parameter EnumParam
@ General' B Detalls | % References |

Parameter type [Enumeration -
Properties
Bt~ | Name | Description
Ox00 zero
Ox01 one
0x02 two

S = |

need additional information to be entered.

3.5.1 Stream parameter

There are three kinds of stream parameters: empty (without a stream case), simple
(with exactly one stream case and without any discriminator parameter) and com-
posed (with one or several stream cases and with a discriminator parameter).

MOST Parameter FirstParameter:
® General B Detals | % References |

EREREsParameter
Parameter type [Stream

Properties -

Stream Type (3 Empty () Simple () Composed
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A short stream parameter differs from a stream parameter in the absence of the mi-

nimal Iength attribute onlz.

m # MOST Parameter pl
@ [ |[Z] | @ cenera’ B Detals | % References |
@-0- 3]

()= p2

Parameter type |Shortsn'eam

Properties

Stream Type (9 Empty () Simple () Composed

Max length [ |

A simple stream is a stream with exactly one use case and without a discriminator
parameter. A simple stream may consist of either signals or parameters. Signals and
parameters cannot be mixed. A simple stream consisting of signals has a byte order
attribute and the signal layout of the simple stream is displayed at the bottom. Its bit
order can be reversed. The byte order attribute and the signal layout view make
sense only for stream cases containing signals. The byte order attribute disappears

as soon as a Earameter has been added.
B BEX

@[ (&) | ®cenera’ B Detais | % References |

-69= 53]
®)=p2

Parameter type |Stream =

Properties

Stream Type () Empty (3)Simple () Composed

Min. length Max. length Byte order |BigEndian vl

Parameter /Signal
Repeﬁtjon‘ Parameter / Signal J Byte ‘ Bit: loﬂ%etl Length
] 1s1: Signal 0 1] | &
252 Signal 1 1 1 2
\ & Add Signal ®

Bitorder: (0.7 7.0

7 | & | 5 | 4 a | 2 1510

A composed stream is a stream containing a discriminator parameter. It may contain
one or several stream cases. As soon as the composed stream type is selected, a
discriminator parameter selection dialog is shown. If no parameter is selected, the
simple stream type will be chosen instead.
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s MOST Parameter P1
f@ General | & Details\(% References‘(% Shared References\

"{szm Parameter type ’Stream b’

F-04= P2

Data Element Group | |

r Properties

Stream Type () Unstructured () Simple (2) Composed () Bit-enceded (MOST 3.0 and earlier)

Min. length Mazx. length Byte order |BigEndian
Discriminator |P2 | E]
Range of values

Range | Code (Start) | Code (End) Description Byteorder

Signall, Signal2 g

[ =F Add ] ’ # Rernove ]
Parameter/Signal
Repetition | Pararmeter / Signal | Byte | Bit | Of'fset| Length
] 1 Signall: Signal 1 i 0 1
] 2 Signal2: Signal 1 1 1 1
’ ﬁAdd Signal ] [ = Add Parameter ] ’ & Delete ]

Bit order: (0.7 (317 .0

7 [ e [ s [ & [ 3 [ 2 | 1 ]| o
1 Signal2 (0... Signall (0...

For every stream case a range with a start and end code can be defined. The end
code can only be inserted if the checkbox “Range” in the first column has been se-
lected. The inserted values will be checked and marked red if they are not compati-
ble with the type of the underlying descriminator parameter. A tooltip is shown with
further information. In a composed stream with several stream cases the description
attribute is editable and the button “Calculate” is active. The button “Calculate” is
used to calculate the stream case description on the basis of the selected parame-
ters or signals.

3.5.2 Number parameter
For number parameters various signed or unsigned base types are available:
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Parameter type [I"-.Iuml;:ler

Data Elerment Group |

ON

MOST®
MOST Editor

M

- Properties

Baze Type

Yalue Rai

Range of

Iﬂﬂn edWord

"I

SignedLong

SignedLlenglong

UnsignedByte
UnsignedWord
Unsignedlong

UnsignedLongleng

SignedByte
S0alely) SignedWord

() hex

Float

Double

Iin

A range of values can be defined. Lower limit and upper limit values for every range
can be entered in two formats: hexadecimal and decimal. Hexadecimal values must
be positive. The value range field shows interpreted values (including negative val-
ues) according to the defined base type, exponent and step:

2= MOST Parame 2 MOST Parameter P2

| | f@ General)( =] Details\{% References\\:% Shared References\
B-60= P1 (2)

---(><]= Parameter type [Number

Data Elermnent Group |

r Properties

Base Type [SignedWord

Exponent |U

| Step |1

Value Range |0x8000, 0xB001 .. 0x7FFE, Ox7FFF

Unit |none

Range of values

(@ hex () dec

Descripticn

4 Add | [

¥ Remove

One can enter negative values in decimal format. The upper and lower limit values
must be within the corresponding base type value range:
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Base Type [SignedE}-'te

~)

Exponent |I:I

| Step |1 |

Value Range |-128, -127 .. 126,127 |

Unit |nn:|ne

Range of values
() hex (3) dec

kin Max =

Descripticn

Mame

For shared parameters (i.e. parameters used by different functions and/or parame-
ters) name and description can be substituted in the tab “Shared references”. In the
following example Parameter “P1” is used in two functions. For “Function2” name
and description has been ovewritten to “Renamed”. The overwritten name will be
displayed italic in the tree view:

# MOST Parameter UByteParam

=) 2

Elﬁxa ParamUniquenessExample [Cx400]
& Status
---(><.'l= InnerStreamParam
---(><)= InnerstreamParam2

()= QuterStreamParam

-"(X)= OuterStreamParam?

(RS /By teParam 3 (3)

[@ General | & Details“;% Referencesf% Shared References\
Shared parameter [ Make shared l [ Un-share/un-merge selected l
References

Override shared name

Reference &
. InnerStreamParam.UByteParam
()= InnersStreamParam2.UByteParam
fio ParamUniquenessExample.Status

UByteParam_2
UByteParam_3

Override shared description

Cwerwritten description
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3.6 Working with signals

)
Ha B X

" B Details | @ References |

@@ .
-G 52 o [Bi]

Signed [ ]

A signal can be signed or unsigned. It must have a length (in bits).

3.7 Saving a function catalog

You can use “File” &> “Save” from the main menu or from the toolbar to save a
function catalog. Your function catalog is stored as MOST database file (*.medb).

If you opened an existing medb file containing a function catalog, worked on it with
the MOST Editor and then clicked save your original xml file will be overwritten.

[@] 1osT Editor 3.4.0.2 - [FCat-Example_DTD_1V2-1.medb]

E Element Help

New CERE X
= Open..
= Save | |

:ISaves the MOST function catalog
3 Close

- @ Methods [0x72]
@ PropertiesWithMultipleParamete
- [l PropertiesWithSingleParameter [

7 FIBEX compatibility...

29 Import...
29 Export..
[H? Generate HTML...

Exit

If you want to save your changes in a new file use “File” > “Save as” from the main
menu.

3.8 Saving as new function cataloge

If you use “File” > “Save as” from the main menu you can choose parts of your cur-
rent function catalog to be saved into a new file.

© Copyright 1999 — 2018 MOST Cooperation. All rights reserved.
Page 49 of 68

MOST Editor — User Manual 06/2018
Document Version 3.4.0.12



MOST® MOST

MOST Editor COOPERATION

[@] MosT Editor 3.4.0.2 - [FCat-Example_DTD_1V2-1.medb]

E Element Help

El New FER X

= Open.. |ﬁ*

Save
2l 4
- (- @ Methods [0x72]

_Cl Saves the MOST function catalog to a newﬁleirties‘u".fithr'-ﬂultipleF'arametE
3 FIBEX compatibility... | PropertiesWithSingleParameter [

E2g Import...
E21 Expoirt...
[H? Generate HTML...

Exit

In the MOST Editor the original function catalog remains open. If you want to view
the newly created function catalog you have to open it in your MOST Editor.

When you have made changes in your MOST Editor and you try to open a function
catalog or create a new function catalog the MOST Editor asks you if you want to
save your changes.

While editing your function catalog may be inconsistent but when you save it your
function catalog must be consistent according to the specification of the MOST Co-
operation.

The following conditions generate warnings when trying to save a function catalog:
- A function catalog that does not contain an FBlock.
- A function that is not attached to an FBlock.
- A parameter that is not attached to a function.
- A signal that is not attached to a parameter.

The function catalog is saved without the elements that are not correctly specified.
The MOST Editor remains open so that you can correct your function catalog.

3.9 Exporting

If you use “File” > “Export” from the main menu you can choose parts of your cur-
rent function catalog to be saved in a new xml file. Different export formats are sup-
ported.

The following pop-up allows you to define which parts of your function catalog you
want to save:
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x|
Save In: ’E Referenz "’] @

Visibility: public private preliminary

Cl:umpletEI @ FBlocks | fiu Functions |

[ ] Generate HTML
[ Export functions into separate HTML files

File Mame: 3G_TWHybrid_0:0CA_VD_3 1.00ml |

Files of Type: |Functicn cataIDEs 31 G500 aemil) "’I

FIBEX Files (*.xml)

Function catalogs 0.6.05.3 (DTD) (*xml)
Function catalogs 0.605.3 (X507 (*xml)
Function catalogs 3.1 (X50) (*.xml)

Only those blocks and functions will be exported that have chosen visibility values.
A new function catalog containing only the selected elements is created on your disk.

One can export all blocks and functions or any part of them into one of two formats:
FIBEX and FCat. The format can be chosen at the bottom part of the dialog.
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3.10 Generating html output

For generating an html file that contains your function catalog select “File” &> “Gen-
erate HTML” from the main menu.

[@] 1osT Editor 3.4.0.2 - [FCat-Example_DTD_1V2-1.medb]

E Element Help

New MEEER.
[= Open.. W
Save
&

Bl saveas.. | |
£2 Close = Methods [072]

@ PropertiesWithMultipleParamete
% FIBEX compatibility... i PropertiesWithSingleParameter [
Ex1 Import.
g4y Export...
Ef Generate HTML...

Exit Exports the MOST function cataleg in HTMLf-:urmath
TT

A pop-up window opens where you can customize the html export. You can save
your whole function catalog or only parts of it as html document.

x
Save I ’E Referenz "] [@

Visibility: [] public private [#] preliminary

Cu:umpletex 3 FEIDcksIﬁxl Functiuns".l

LSc hema 3.1 "’]

[ ] Export functions into separate HTML files

File Mame: | |

Files of Type: |HTML files (*.html) ~|

[ Save _J [ Cancel ]
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You can select the stylesheet and an option to export functions into separate HTML
files.

In addition to the html file a file called most.css is saved. This file prettifies the html
output with background color and the like. Without this file you still can view your
function catalog in a browser but it doesn’t look as nice as it does with most.css in
place.

A Function Catalog - Microsoft Internet Explorer

Datei Bearbsten Ansicht Favorten Extras ? -
) ) A © < ’; oL Rgl - 3
€ o |ﬂ E" () ) suchen 57 Favorten 2 = _I i3
advesse | PAMOST-EditoriSamples|ySample html v| B wechseinau  Loks
~

Function Catalog

Function Block Overview
FBlockID Name
0x60 MyFBlack

MyFBlock (FBlocklD=0x60)

Releaze: 0.0.1

Date: 2007-12-11
Author: Angela Wiesheu
Company. Sulzer

Modifications

Change Reason
FElock for demaonstration of MOST Editor usage

Function Overview
FktlD Name Section Type
MyFirstFunction | Coordination

MyFirstFunction ()
Section type: Coordination

This is a function far demonstration purposes

Format of Function
Function classes: Unclassified Property

FBlock Function OPType Parameter
MyFEBlock (0xB60) My FirstFunction () Set FirstParameter
Get SecondParameter
Parameter

FirstParameter

&] Fertig %J Lokales Intranst

3.11 Analyzing a function catalog

The MOST Editor offers functionality to analyze a function catalog to get an overview
of the elements it contains and to identify inconsistencies.

3.11.1  Quality

When you select “Quality” in the task tree and press the “Calculate” button at the bot-
tom of the detail editor all items that seem to be incorrect are listed.
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MOST Editor 3.0 - [FCat-Example_DTD korrigiert.xml :: FCat]
File Element Help
Q- O~ eHa B X

Task Analysis i

MOST Quality -
Analyze quality of the bus topology. J
Analysis
& Quality ‘I Description Type MName
i Identifier @ OPType Set: Parameter 'ArrayP... MOST Function DynamicArrayOfRecordsProperty
i References @ OPType Set: Parameter 'ArrayP... MOST Function LongArrayOfRecordProperty
@ OPType SetGet: Parameter 'Arr... MOST Function DynamicArrayOfRecordsProperty
@ OPType SetGet: Parameter 'Arr... MOST Function LongArrayOfRecordProperty
@ OPType Status: Parameter 'Arr... MOST Function DynamicArrayOfRecordsProperty
@ OPType Status: Parameter 'Arr... MOST Function LongArrayOfRecordProperty
@ parameter coding ranges excee... MOST Parameter BitSetParameter\Word
[ Calculate ]

FCat-Example_... | | |

A double click on a quality analysis entry opens the respective editor window where
you can correct the error.
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3.11.2 Identifier

By choosing Identifier from the task tree and specifying the element type at the bot-
tom of the detail editor you can list all elements of the selected element type ordered
by their identifier.

File  Element Help

QO BEeHo TEX

MOST A Identifier 3.0
Find out all identifiers, - !

D Catalog ‘[)

[ FBlock

ﬁﬁd Funiction {Identifier | Type I MName

)= Parameter 040 MOST Felock AMFMTuner

& signal 0x43 MOST FBlock FMAFTurner

IS Uit k83 MOST FElock MFATUrmEr

Analysis 2

& Quality

i Identifier

i References

Element type |MOST FElock |7| Calculate

D Unnamed | |

A double click on a line opens the respective editor window.
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3.11.3 References

In the references section you can find all unreferenced elements. This is especially
important as you cannot store unreferenced elements.

File  Element Help

@O Bedo HNEX

MOST A References .
Find unreferenced elements, ‘E@

Catalog
[ FBlock
_ﬁu Function | Description Type I Marne
)= Parameter "1 The element is not used MOST Funckion AnotherUnreferencedFunction
@ signal i The element is not used MOST Function UnreferencedFunction

7% Unit i The element is not used MOST Parameter UnreferencedParameter

Analysis 2

& Quality
i Identifier
i References

Calculate

Unnamed

A double-click on a line opens the respective editor window.
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3.11.4 Identical objects

In the identical objects section you can identify all identical parameters for a given
search scope:

(1 MOST Editor 33,01 - [bbb.medb

File Element Help

l0-0- BeEm

MOST ¥ Identical Objects
Resolve and merge identical objects.

Analysis

‘55 Qual\.t).r Scope (2) FBlocks () Functions : i
1 Identifier
i References Name =

T Identical objects Methods
PropertiesWithMultipleParamet...

PropertiesWithSingleParameter Description | [H) HTML

Position description for a record or an array.

MName |Position

Select Filter ][ Caleulate

Duplicate parameters

Name =
MNSteps (7) Reason
MNSteps (7)
PosY (3]
SourceMr (3)
Tag (3)
TaggedArrayParamOfRecord (3)
UWordParam (2)

Merge All 4k Add ¥ Remove ]
bbbmedb | [ [ [ 29 0f31M (maxazamy |

To define a search scope use the “Select Filter” button and select one or more of
either FBlocks or Functions from the provided list. Press “Calculate” to start search-
ing for identical parameters within that scope. All duplicate parameters will be shown
in the list of duplicate parameters below. You can select one or more parameters
from that list and pressing the “Merge” or “Merge All” button will remove all duplicate
parameters within the referenced elements. If the merged parameters are not used
anymore outside the search scope a message dialog pops up:

CHEEES TR

Q 3 Parameters have been merged and are not used any lenger.

Do you want to delete these parameters ?

Confirming with “Yes” will delete these unused parameters permanently. If you select
a parameter from the duplicate parameters list the related details of that parameter
will be show on the right side.
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3.12 Toggle between tree/table element viewing modes

MOST elements can be viewed in two modes: tree and table. In the tree mode one
can clearly see the hierarchical structure of the elements.

@I MOST Editor 3.0

File Element Help
GO BeRa TEX

MOST Fncion Detais
MOST A I:I
ride & fio MyFirstFunction

i |1

= Eg::ra‘::er e § (Sx)e=t " - .

2 | R In the tree mode one can clearly see the hierarchi-
T Eemons cal structure of the elements.

Analysis ¥ ®-69= pNumber
B-(9= pRecord

By clicking on the icon one can switch back and forth between tree and
table modes.

In the table mode one can see the values of the most important attributes of the
elements.

@ MosT Editor 3.0
File Element Help
OO Beda KBEBX

MOST

Name Identifier Class Section Visibility

[ catalog
@ FBlock

foo Function
®=Parameter
@ signal

T Unit

classified Property public
MyFirstFunction Record public

MOST Function MyFirstFunction
@ Gereral ' B Detals | % References |

Analysis ¥

D]

Identifier W I ®hex (O dec Section l ‘

o — R — vosesen [

Function Class

|Unclassified Property J |

Error V

Lot i

OPTypes Parameter
OPType \ Channel Parameter

Set

[ Unnamed [ [ [

3.13 Comparing two FBlocks that are stored in different
function catalogs

You can compare two FBlocks that are stored in different function catalogs by im-
porting the FBlock to compare in your current FBlock.
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1. Open the first function catalog in your MOST Editor.

2. Import the FBlock from the other function catalog (see section 3.2.3 Importing
from existing function catalogs). The original and the imported FBlock are dis-
played in the detail tree.

3. Now, you can mark both FBlocks and choose “Compare with each other” from
the context menu (press right mouse button). See section 3.1.7 Compare
elements.

3.14 Command line converter

The MOST-Editor includes a small command line converter which allows performing
conversions between export formats or running the quality checker. The command
line converter is distributed as “MOST-Converter.exe” within the standard installation
directory of the MOST-Editor:

-~

Mame Anderungsdaturm Typ Grafe

|| i Text-rif-2.1.3,jar 22,08.2008 14:56 Executable Jar File 153 K
|| javax.persistence_2.0.3.»201010191057 jar 22,03.2011 15:09 Executable Jar File 124 K
|| jdom-1.1.jar 15.07.2008 11:59 Executable Jar File 150 K
|} jh-2.0_05.jar 18.01.2010 08:01 Executable Jar File 52K
| logdj-1.215.jar 31.08.2007 16:55 Executable Jar File 383K
| looks-2.2.0.)ar 21.08.2008 14:06 Executable Jar File 401 K
|| mail-1.4.1,jar 26.08.2008 17:26 Executable Jar File 363 K
|| merror201204261404104 . log 26.04,2012 14:08 Textdokument 1K

|@ MOST-Converter.exe 14.03.2012 10:41 Anwendung 79K
R St Dateibeschreibung: MOHSI'I'-EDH:.:Erter 3.3.0.]:-@ MOST .Ccu:up.eraticun, Incg, sl
1B MOSTCo-5plash.gif 2007-2012 72 K
,@ MOST-Editor.exe Firrna: MOST Cooperation 70 K
— Dateiversion: 3.3.0.1

& MOST-Editor.ini Erstelldatum: 14.03.2012 10:41 2K
|&] MOSTEditor-3.3.0.1,jar | GroBe: 78,5 KB 46 K
|| MOSTEditer-3.3.01 . jar_cld 14.03.2012 10:39 JAR_OLD-Datei 11.016 K
| poi-3.7.jar 23.11.2010 21:16 Executable Jar File 1636 K
|| serializer_xalan.jar 24,03.2011 07:32 Executable Jar File 185K
|| swingx-0.9.5,jar 24,03,2009 09:23 Executable Jar File 1223 K
| xalan-2.7.0.jar 24.03.2011 07:32 Executable Jar File 3007 K
|| xbean_xpath-1.0.jar 15.07.2011 15:00 Executable Jar File TE

[N MR T 4 R AT VAT ALnA | SR [ ) [ NP - N Loh W

Usage:

most-converter.exe —convert --targetDTD6V5_3 --log <log_file1> <input_file1>
<output_filel> <input_file2> <output_file2>

most- converter.exe --check --silent --log <log_file1> <input_file1>
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For using the converter the command line arguments needs to specify a command
as first attribute. The following commands are supported:

--convert (convert between input and output file(s) using a format)

--check (quality check of the input file(s) )

“--convert” is used for conversion between formats and “--check” is used for running
the quality checker.
When specifying “--convert” one of the following target formats must be specified:

--targetDTD6V5_3 (FCat DTD)

--targetFIBEX3V1 (FCat Fibex)

--targetSchemaOVv6_5 (FCat XSD V065)

--targetSchema3V1 (FCat XSD Rev. 3.1)
Optionally the following arguments are allowed:

--log (specify the name of the log file)

--silent (disables information output on the screen)
Examples:

most-converter.exe --convert -- targetSchema3V1 --log log.txt Inputl.xml Outputl.xml
Input2.xml Output2.xml

Convert the input files (Inputl.xml Input2.xml) to the output files (Outputl.xml Out-
put2.xml) using FCat Rev. 3.1 XSD format and create a logfile named ,/og.txt*
most-converter.exe --check —silent --log log.txt Inputl.xml

Do a quality check of the input file (Inputl.txt) in silent mode and create a log file
named ,log.txt“. The result of the quality check will be written to a file named ,In-
put1.xls*

For using blanks in file or path names you need to embrace the input and output pa-
rameters with quotation marks.
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4q Principles and concepts guiding the MOST
Editor

4.1 Top-down approach

The MOST Editor is guided by a top-down approach. You can start creating your
high level elements and add the details later on. You start for example by creating an
FBlock, then you create functions that you attach to your FBlock and parameters for
your functions. Then you add the details to your FBlocks, functions, parameters and
signals. So you can start with the big picture and then work down to the details.

Of course you can also work bottom-up with the MOST Editor by defining the para-
meters that you will need first, then all the functions and finally your FBlocks but the
more convenient way to create a function catalog usually is the top-down approach.

4.2 Infix-Filter

The infix-filter in the detail tree is a very powerful tool for searching elements.

-MOST Editor 3.0 - [3G_TVHybrid_Ox0CA_VO_3_1.xml :: FCat] D@
File Element Help

- BEela (B X

b ——— —
‘ | MOST A F ] [source

& fo Source [Ox20A]
- fio SwitchSource [0x208]

[ catalog
@ Felock

Jw Function
©=Parameter
@ Signal

% Unit

Analysis ¥

B 36_TvHy... | [ [

In the task tree you select an element type for example “Function”. In the detail tree
all functions are displayed. When you enter a string in the infix-filter only those ele-
ments containing this string are shown. The infix-filter is not case-sensitive and it
searches for the string entered in the whole name of the element not only at the be-
ginning.

4.3 Reuse of existing elements of a function catalog

You can reuse elements within your function catalog. When you attach an inferior
element to your element you often can choose between “Add” and “New”. “Add”
usually opens a dialog where you can select an existing element whereas “New”
opens a dialog to create a new element of the required type.

For example adding a parameter to a function
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MOST Editor 3.0 - [3G_TVHybrid_0x0CA_VO_3_1.xml :: FCat]
File Element Help

O BEela EX

ask MOST lrz MOST Function SwitchSource:
r—— ® General' B Details | @ References |

Catdog fro Source — Identifier @ hex () dec Section |App|icau‘on
e | vy oceurrence [+
9= Parameter v [ ] webknown [ ~|

@ signal
7% Unit: Function Class

[Undassiﬁed Method q

D

Analysis ¥

Error v |4

OPTypes Parameter

OPType Channel Parameter
Abort
StartResult SourceNr
Processing
Result SourceNr
Error ErrorCode, Er... K L

ETR A

Parameter

x

ErrorCode: Void
(refer to section "Structure of MOST Protocols : OPType')

[«]

3G_TVHybrid_0x0C... | | |

By pressing “New” you attach a newly created parameter to your function. By press-
ing “Add” you can select one of your already created parameters. Clicking “Remove”
only removes the references to the element but not the element itself even if the
element has no other references.

4.4 Predefined elements

4.4.1 Units

The MOST Editor has a set of predefined units that are available on startup. Never-
theless, you can add your own units.

[® mosT Editor 3.0 - [AMFMTuner_060710.xml :: FCat]
File Element Help
(€M) o BEX

s =
e l:’ ® General | % Referenzen |
Catdlog E - (]| | Name: [Byte ‘
@ FBlock == Code: [oxCo | D: [unit_Byte \
foo Function [T 360_deg/2pow32 =
®=Parameter [T 360_deg/2pows Group: [Data |
@ signal Ma
7% Unit mA
I bar
73 bit
Analysis

4.4.2 OPTypes

OPTypes are predefined by the MOST specification. You can choose from the fol-
lowing OPTypes:
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List of elements

Choose one or mare elemants, @

Ly Set

Ry Get

&y SebGet

& Increment
& Cecrement
Ly GetInterface
%y Status

&y Interface

& Errar

Note that you can choose several OPTypes at a time. If you want to select more than
one element you can use the popular mechanism of pressing “Ctrl” while clicking on
the elements you need. If you want to select consecutive elements you can mark the
first element you need then press “Shift” then click on the last element you need. All
elements between the one marked first and the one marked last are selected.

4.5 References

The “References” tab in the detail editor shows which elements reference the se-
lected element to be able to judge the consequences of changes to this element.

MOST Parameter ErrorCode

(@ General ', [ Details * g References |

References

few ATRI_Freq (0.0.1) [oxC0:]

fro ATRegionCods (0,0, 1) [OxC05]
fro ATRegiorCodelnfo (0.0, 1) [OXCOR)
fig ATakskions (0.0.2) [oxC10]

fou DTakations_Freq [0.0,1) [0xC17]
fio BTvI15wiEch (0.0.1) [0xFS D)

fro Radictext [0.0.1) [045A]

foo TRSEatus [0.0.2) [0xC05]
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How-To / Tips and tricks / FAQ

5.1 How can I incorporate the MOST Editor in the con-
text menu of my explorer?

Open your windows explorer and move to a directory that contains MOST xml files.

| File Edit view Favorites Tools Help

| Qeack + 5 - ¥ | O seach | Foiders | i 3 X ©) | -

J Address IE} D:{Temp

Folders X | | Name = | Size | Type
@ Desktop - P Open 24KB XML DTcument
(2} My Documents 5 feat.dt Edit 20k8 DTD File
=] Q My Computer 7-Zp >
3z Floppy (A:)
3 \ Scan for Viruses. .. |

@ SYSTEM(C:)

B S DATA (D2) Open With d U2 v editor

) csc Q@ VinZip * (A wordPad

) Documents and Settings send To » & Notepad

1) Downloads — T @ Internet Explorer
= con [W] Microsoft Office Word

) Miniwas S5 -
(= msdownld. tmp Create Shortcut Choose Program...

15 MSOCache Delete

Right-click on your MOST xml file. If the MOST Editor is not available in your context

menu select “Choose Program”.

-~ Choose the program you want to use to open this file:
-

File:  MySample.xml

21

Programs

[@ Recommended Programs:
"E Internet Explorer
E Microsoft Office Word
3 MNotepad
B WordPad
%
[@ Other Programs:
(0 7za32
] 7-zip Conscle
7-Zip File Manager

7-Zip GUI
s ]

Bdeb e Mmmdan o A

[™ Always use the selected program to open this kind of file

Browse... |

|

If the program you want is not in the list or on your computer, you can look

for the appropriate program on the Web.

o]

Cancel
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If the MOST Editor is not in your program list you have to search for it in your file sys-
tem. The standard location for the MOST Editor is C:\Program Files\MOST Coopera-
tion\MOST Editor\MOST-Editor.exe.

Look jn: | & MOST Editor 3 [ s A
jre
My Documents
=
ar
-
File name: II'v'IOST—Ed'rtnr.exe j QOpen
Files of type: Ingmms ﬂ Cancel |
P

Select “MOST-Editor.exe” and click “Open”. The MOST Editor is now selectable in
your programs list.

openwith 21|
- ,] Choose the program you want to use to open this file:
Lh

File:  MySample.xml

rPrograms
E Firefox ﬂ
Freemind

& govien32

Media Player Classic

¥ Microsoft Baseline Security Analyzer J

ﬁ Microsoft Office Document Imaging
Microsoft Office Excel

@ Microsoft Office Picture Manager
@ Microsoft Office PowerPoint
Microsoft Project

MOST Editor
2 |

Wb o

¥ Always use the selected program to open this kind of file;

If the program you want is not in the list or on your computer, you can look
for the appropriate program on the Web,

Ok I Cancel |

Select the MOST Editor and click “OK”. Now the MOST Editor can be used from the
context menu item open within the Window Explorer.
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Note: If you check the box “Always use the selected program to open this kind of file
the MOST Editor will automatically start when you double-click an xml file. If you
don’t want this behavior uncheck this box.

Now you can use the MOST Editor from your context menu:

Fie Edt View Fevertes Tosk  Help

-.Gg,d.; =) - ¥ | Dseach ([ roders | (@ O X M) | -

| Acdress |._:l D\ Temp

Foldars Mame & [ Sire | Type
(8 Desiton 1= feat.ded MKB D7D Fle
# ) My Domments w{: 29KB XML Document
k= _n.l My Compuier Edit
M g 32 Flappy (A0 770 5
[H e SYSTEM (2] e —
= <& DATA i) Scan for Viruses...
® ) s Cpen With b T!-; ¥ML Ecitar
® |23 Documents and Settings & WnZp b
e | :.30-"“';\::“19 SendTo ¥ WardPad
1= TCon o B Noteped
¥ G Mmias ’ A et e
By & Internet Explarer

=) medawnid, e
= 2 Me2Cache

I}EI Mizrosaft Office Ward

Create Shortcut

= ) Programs Delete Choose Program,..

W BEAYS 2R I

5.2 Can I use shortcuts?

You can use shortcuts in the main menu. If you press Alt + the underlined character
in the main menu this menu item is opened.

[® MOST Editor, - Version 2.0,
Element  Help
e

= Open...

Save

[;“‘[l Save as... H |:

3 Close

f2g Import...
[H @enerate HTML...

Exit

g T

When the menu item is open you only need to press the underlined character.

For example by pressing Alt + f and then pressing n you create a new function cata-
log. Furthermore, you can navigate in the submenu with your up and down cursor.
For example you choose Alt + e which opens the “Element” menu item in the main
menu then you use the cursor down to select “Delete” and press “Enter”.

For several elements there are special shotcuts:

Ctrl + N Creates a new element of the same type
Ctrl+ C Copies an element

Ctrl + X Deletes an element

Ctrl + Z Undo (use on description fields only)
Ctrl +Y Redo (use on description fields only)
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In the task tree no shortcuts are available. You have to use your mouse there.
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5.3 How can I quickly access previously edited ele-
ments?

The navigation elements in the toolbar allow you to easily navigate through the ele-
ments you have already edited.

M MOST Editor 3.0 - [AMFMTuner_060710.xml

File Element Help
OO BExEa TEX
L —]
feo ATRegionCode [0xCO5] Block I
fo REG [0x452]
@ AMFMTuner [0x40] _
™ pyte MTLiner [Ox40]
: A TWaveband [Ox201
B - fiv ATStationinfo [0x20
J Function '
.. Far A TC AR TANAT
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